
Introduction

The PC software package (STSW-ST25R019) contains the ST25R200 Eval GUI and the ST25PC-NFC software (STSW-
ST25PC001).

The ST25200 Eval GUI allows the user to communicate with the ST25R200 evaluation board (STEVAL-25R200A). It provides 
an interface to change a wide range of settings. It also allows different features of the STEVAL-25R200SA kit to be executed 
and evaluated. This user manual provides a detailed description of the ST25200 Eval GUI.

The ST25PC-NFC software (STSW-ST25PC001) allows access to all features of the ST25 NFC/RFID tags and ST25 dynamic 
NFC tags. It is not the object of this user manual.

The PC software must be used with the ST25R200 evaluation board, which contains all the necessary modules for a fully 
functional NFC reader.
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1 Preface

1.1 Downloading and installing the software
After downloading the software (available at st.com), double-click the executable file to begin the installation.
• Select whether to install the software for each user of the PC or only for the current user.

Figure 1. Selecting install mode

• Select the path to install the software.

Figure 2. Selecting the program destination
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• Select the location for the demo file.

Figure 3. Selecting the demos source code directory

• It is possible to add the ST25R200 evaluation GUI to the start menu. This is recommended to allow the 
user to always find the software easily using the Windows® search function. If the user does not want to 
add the software to the start menu, they just need to tick the checkbox in the bottom left corner of the 
window.

Figure 4. Selecting a start menu folder
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• To create a shortcut on the desktop, tick the checkbox shown below.

Figure 5. Creating a desktop shortcut

• The figure below shows a summary of the selected installation directories. Click install.

Figure 6. Ready to install
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• Installing takes no more than a few minutes to complete. Launch the application by clicking the finish 
button.

Figure 7. Installation completed

Note: This software is only available for PCs running on Microsoft® Windows®.
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1.2 Hardware preparations
The ST25R200 evaluation board (STEVAL-25R200A) consists of an STLINK module, an ST25R200 core module, 
and various antenna modules.
The STLINK module allows easy programming and debugging of the firmware and acts as a communication 
interface for the ST25R200 core module. The ST25R200 core module consists of an STM32G0 MCU and an 
ST25R200 NFC reader.

Figure 8. ST25R200 evaluation board - top view

All three modules are connected by default. The user can also use the other antenna modules. The 
STEVAL-25R200SA kit is described in a separate user manual (UM3199).
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The AUXIN and AUXOUT pins are located at the bottom of the board. These are for general use and are 
displayed in reader + tag demo mode as described in Section 3.2: Reader+Tag Demo tab.

Figure 9. ST25R200 evaluation board - bottom view
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2 Reader mode

The application offers two different GUI modes:
• Reader mode

It allows the user to explore a wide range of functions in detail.
• Demo mode

A more compact mode that provides a simpler and more intuitive interface for demonstration purposes
This section provides an overview of all the functions available in reader mode.

Figure 10. GUI modes

The brighter blue color indicates that reader mode is enabled. To change the mode, click on the appropriate icon. 
The third icon launches the ST25PC-NFC GUI application (see st.com for more information on it).

2.1 Main tab
The Main tab contains the Board Info tab and the Overview tab.

2.1.1 Board Info tab

Figure 11. Board Info tab

The Board Info tab allows the GUI to be connected to the ST25R200 evaluation board. To connect a board, 
ensure that the correct COM port and baud rate are selected.
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When a board is connected, this tab displays basic information about the connected hardware.
• Firmware version

The firmware version currently running on the MCU.
• Demo board version

The type of demonstration board.
• STM32 UID

The unique ID of the STM32 on the ST25R200 core module.
The Update Firmware button allows the user to update the firmware running on the STM32G0 on the core 
module. See Section 4.2: Updating the firmware for more information.

2.1.2 Overview tab
The Overview tab is a quick demonstration showing a typical NFC application combining wake-up mode and 
NFC polling. As soon as wake-up mode detects a variation, standard NFC polling is performed and the cards/
devices found are listed.
The demonstration remains in polling mode until no more cards/devices are detected.

Figure 12. ST25R200 overview
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A small window with settings opens after clicking on the Polling Configuration button.

Figure 13. Polling configuration

These settings allow the user to enable/disable polling for different technologies. It is also possible to enable 
polling only and not to perform a wake-up.
To view the tab in full screen, click on the extended view icon.

Figure 14. Extended view

Click the same button again to exit full screen mode.

2.2 Features tab
This tab allows the user to discover the different features of the ST25R200 in the subtabs. Each subtab 
represents a feature and provides different settings for the corresponding functionality.

2.2.1 Power tab
The Power tab allows the user to set the ST25R200 to five different modes:
• Reset
• Power-down
• Wake-up
• Ready
• Ready + Field on
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Each mode has a different power consumption (use the pins of R37 to measure the actual power consumption of 
the chip. For more details, refer to UM3199). The mode can be changed using the radio buttons on the left. The 
bar graph on the right side visualizes the different power consumption of the different modes. The currently 
selected mode is highlighted by a darker color in Figure 15.

Figure 15. Power consumption
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2.2.2 Field Measurement tab
This tab displays the intensity of the ST25R200's own field and the presence of an external field. It is possible to 
switch between these options using two radio buttons.

Figure 16. ST25R200 Field Measurement

Click the Measure button to take a single measurement. If the continuous acquisition checkbox is selected, 
clicking the measure button starts repeated measurements. To stop the measurement, click on Stop Measure.
The result of the measurement is visualized in the center of the tab with a numerical value and a circular element.

2.2.3 Wake-up tab
The wake-up mode uses very low power to detect if an object has entered the reader field. The field is switched 
on for a short time to measure whether an object has entered the field. The measurement provides the I and Q 
channel values. For more information, see the ST25R200 datasheet (DS13658) and application note (AN5993).
Two graphs show the measured I and Q values. Click the Start button to start wake-up mode. The graphs in pink 
correspond to the measured values. The blue-colored graphs represent the upper and lower thresholds. The last 
measured I and Q ADC values are displayed above the two graphs.
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Figure 17. Wake-up tab with the configuration shown

By default, a wake-up is triggered when the pink line (measurement) crosses one of the blue lines (threshold). 
When a wake-up interrupt is triggered, the pink line is marked with a circle.

Figure 18. Wake-up tab with the configuration hidden

Click on the Show configuration button to display the wake-up mode settings. These settings are mainly those 
found in the ST25R200 datasheet (DS13658). To change the settings, stop wake-up mode if it is currently 
enabled.
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Figure 19. Wake-up configuration shown

Click the Send To Overview button to apply the selected settings to the wake-up functionality provided by the 
Overview tab (refer to Section 2.1.2: Overview tab).

2.2.4 Analog Config tab
This tab contains important configuration settings required to set chip-specific configurations for different 
technologies and bitrates at different operating times. The concept of analog configuration is part of the RFAL 
library and is used throughout the different ST25R devices. See the RFAL user manual (UM2890) for more 
details.

Figure 20. ST25R200 Analog Config tab

The Analog Config tab is divided into the Mode, Functions, Actions, and Hashes sections.

Mode

The Mode section provides a drop-down box containing several chip-specific supported technologies and events. 
A specific mode can be added to the mode list. This makes it easy to have individual settings for all transmit and 
receive modes. The CHIP_INIT mode sets global registers that must be used independently of other selected 
modes. For example, the pull-down of SPI lines can be enabled.
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Functions

The Functions section contains register values associated with modes. A function consists of a name, the 
corresponding register, a mask, and the required value for the register. Frequently used functions can be selected 
from the drop-down box and added to the functions list. These functions are already defined and can be selected 
from a drop-down box.
For better readability, modes can be ordered using the up and down arrows in the mode section.

Attention: Be careful when defining the same registers or functions for multiple entries in the mode list: for example, if a 
function is added to ISO 14443A and not restored in ISO 14443B mode, it is also applied to ISO 14443B.

Actions

The Actions buttons complete the analog configuration concept. They read and write information to the board or 
to the PC.
The Read from board button reads the analog configuration from the connected board.

Note: The values currently displayed on the GUI are overwritten.

The Write to board button writes the current configuration from the Analog Config tab to the connected board.

Note: If the Analog Config tab is left empty, the board remains with its stored values.

The Load from file button is used to load a previously saved configuration file into the Analog Config tab. Use 
Write to board to write these newly loaded settings to the connected board.
The Save to file button saves the current configuration in the Analog Config tab to the file system. The 
Generate custom code button can be used to automatically generate a C header file for direct inclusion in a 
compiled firmware image. See the RFAL user manual (UM2890) for further details.

Hashes

The Hashed section shows the analog configuration hashes currently loaded into the different areas. The FW 
active (RAM) field is the configuration currently in use. It can be different from the FW stored (Flash) field. The 
FW stored (Flash) field contains the hash value that is loaded when the chip is switched on. It is possible to load 
an analog configuration temporarily until the chip is switched off and on again. Click on Write to board without 
ticking the Store to flash checkbox to load a temporary configuration.

2.3 Debug tab
The Debug tab allows the user to access the ST25R200 at lower levels. Specifically, the user can explore the 
different technologies in detail using the NFC-A / ISO 14443A, NFC-B / ISO 14443B, and NFC-V / ISO 15693 
subtabs. The Low level subtab is not dedicated to a specific technology. It allows the user to control the 
assembled reader chip using chip specific commands as specified in the DS13658 datasheet.
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2.3.1 NFC-A / ISO 14443A tab

Figure 21. NFC-A/ISO 14443A tab

The NFC-A / ISO 14443A tab allows the execution/debugging of the different stages of NFC-A technology in 
accordance with the NFC Forum™/ISO 14443A standard. The GUI highlights the next button to click to assist the 
user. If the button is clicked and the operation is successful, the next suggested button is highlighted in blue. If a 
card is present, successful communication guides the user through the TechnologyDetection and 
CollisionResolution steps. The user then activates the card by clicking HandleActivation. After activation of the 
card, the user sends predefined or custom commands to the card using the Transceive button.

Note: NFC Forum and the NFC Forum logo are trademarks of the Near Field Communication Forum.
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2.3.2 NFC-B / ISO 14443B tab

Figure 22. NFC-B / ISO 14443B tab

The NFC-B / ISO 14443B tab provides functionality to execute/debug the different stages of NFC-B 
communication according to the NFC Forum™/ISO 14443B standard. The GUI assists to the user by highlighting 
a suggestion of the next button to press. The highlighted buttons take the user through the Initialize, 
TechnologyDetection, CollisionResolution, and HandleActivation steps.
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2.3.3 NFC-V / ISO 15693 tab

Figure 23. NFC-V / ISO 15693 tab

The NFC-V / ISO 15693 tab provides functionality to execute/debug the different stages of NFC-V communication 
according to NFC Forum™/ISO 15693. It provides help to the user by highlighting buttons to press. The 
highlighted buttons guide the user through the Initialize, CheckPresence, and CollisionResolution steps. After 
that, it is possible to execute ReadSingleBlock(s) to read one block of the card memory.

2.3.4 Low level tab

Figure 24. Low level tab

The Low level tab allows direct control of the ST25R200 reader mounted on the board. For details, see the 
ST25R200 datasheet (DS13658).

UM3364
Reader mode

UM3364 - Rev 1 page 18/33



3 Demo mode

The demo mode displays certain features of the ST25R200 with a richer visual interface, including full screen 
support. To activate demo mode, click on the demo mode button in the toolbar.

Figure 25. ST25R200 toolbar

3.1 Antenna Eval tab
In this tab, it is possible to select the current antenna configuration of the ST25R200 evaluation board and start 
the polling loop for this specific configuration. The radio button is used to toggle between the antenna 
configurations. A click on find activates the polling loop.

Figure 26. ST25R200 Antenna Eval tab

The image shows basic information about the tag found.

Figure 27. Tag information

UM3364
Demo mode

UM3364 - Rev 1 page 19/33



In dual antenna mode, the map information indicates which antenna it is detected on.

Figure 28. ST25R200 dual antenna mode

The above figure shows a PCB with two NFC coils, each of which polls independently.
The following figure shows when an antenna detects a card.

Figure 29. Antenna detection

UM3364
Demo mode

UM3364 - Rev 1 page 20/33



3.2 Reader+Tag Demo tab
This tab allows rapid prototyping of NFC use cases. For example, the user can use a tag to turn on an electrical 
component.

Figure 30. Reader+Tag Demo tab
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As illustrated above, the tab is divided into two sections, one for the reader, the other for the tag.
• The right section represents the tag

The user can place a tag on the reader, then read it or write to it using the Read Tag and Program Tag 
buttons. When writing a tag, it is possible to assign one of four IDs to the tag (ID: p01 to p04). The speed 
parameter is another property that can be set. The reader can read this speed setting, which allows an 
action to be performed at a slower or faster speed. The No. of Usage field represents the number of times 
the tag has been used in the demonstration.

Figure 31. Tag section
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• The left section represents the reader
When a tag has been programmed with an ID (of p01 to p04 as explained above), the user can select an 
action from the drop-down menu to the right of the LED1/2/3 fields as illustrated below.

Figure 32. Drop-down menu

For example, the user can select "On/Off Accessory: p0x" with x = 0 to 4, where p0x is the ID of the tag.
After selecting an action, click the Write Reader Config button to flash the MCU.
The demonstration is now set up. To start it, click the Start Standalone Demo button. If the user now 
places a tag with the correct ID on the reader, the corresponding LED lights up.

Note: The tag can be assigned to any ID using the controls on the right side of the tab as described above in 
The right section represents the tag.

Figure 33. Reader section
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Output switch settings

If the user enables the output switch settings, they can assign the function to work with any tag ID using the drop-
down menu of the Trigger field. The Mode field can be set to "toggle on/off "or to "PWM speed". This toggles the 
AUXOUT pin on the board. This is the pin in the bottom left corner in the figure below.

Figure 34. ST25R200 module (backside)
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4 Other dialog boxes and panels

4.1 Register map
In the menu, click View > Register Map to open the register map.

Figure 35. Open the register map

The Register Map window, shown in the figure below, is a view that displays all registers and their values. It also 
allows changes to the register settings.

Figure 36. Register map

When the Register Map window is open, it displays a list of register names with their addresses on the left side. 
On the right side, it shows the register values in hexadecimal. Between the register names and the register 
values, there are also 8 bits, which represent the current contents of the registers. Click on a bit to toggle the state 
from 1 to 0, or vice versa. This feature is disabled for some read-only registers. When it is the case, the register 
bits are grayed out.
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4.2 Updating the firmware
To update the firmware, do one of the following:
• Click the Update Firmware button in the Board Info tab.
• In the top menu, click Help > Firmware Update.
• Press CTRL + F.
The Firmware update dialog box illustrated below allows the flashing of firmware on the MCU of the ST25R200 
evaluation board directly from the ST25R200 Eval GUI. The GUI comes with firmware for the evaluation board. 
The firmware combo box shows all the pieces of firmware located in the firmware folder specified by the firmware 
dir parameter. The latest version of the firmware can be found at st.com. Clicking the Update Firmware (using 
mass storage transfer) button flashes the firmware to the board. If multiple boards are connected, ensure that 
the correct board is selected in the Boards combo box.

Figure 37. Firmware update
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4.3 Logging
The Logging window is at the bottom of the GUI. It can be enabled/disabled in the View menu by selecting 
Show/Hide > Logging. It shows the entire communication between the GUI and the connected reader. Any 
request from the GUI is displayed in gray, while a positive response is displayed in green.

Figure 38. Logging

If the communication fails for any reason, this is indicated by a red font in the Logging window.
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4.4 Help panel
To the right of each tab, there is a help panel that provides basic information about the current tab.

Figure 39. Overview
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IMPORTANT NOTICE – READ CAREFULLY

STMicroelectronics NV and its subsidiaries (“ST”) reserve the right to make changes, corrections, enhancements, modifications, and improvements to ST 
products and/or to this document at any time without notice. Purchasers should obtain the latest relevant information on ST products before placing orders. ST 
products are sold pursuant to ST’s terms and conditions of sale in place at the time of order acknowledgment.

Purchasers are solely responsible for the choice, selection, and use of ST products and ST assumes no liability for application assistance or the design of 
purchasers’ products.

No license, express or implied, to any intellectual property right is granted by ST herein.

Resale of ST products with provisions different from the information set forth herein shall void any warranty granted by ST for such product.

ST and the ST logo are trademarks of ST. For additional information about ST trademarks, refer to www.st.com/trademarks. All other product or service names 
are the property of their respective owners.

Information in this document supersedes and replaces information previously supplied in any prior versions of this document.

© 2024 STMicroelectronics – All rights reserved
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